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Introduction 
The evolve Multi-Leg pricer (MLP) is a tool which allows you to create quotes consisting of multiple legs, groups of legs and strips 
of legs. 
Using the Multi-leg pricer you can also create single and multi-leg line and multi-line graphs, solve to generate a desired result, save 
and share quotes and, when needed, turn priced quotes into book deals. 
 

Using evolve evolve has a number of features to help you get results more efficiently and these include: 
• evolve will fill in as much default information as possible. 
• When you enter data and press the return key, evolve will move the cursor to the next field that requires 

an entry. 
• When you select a field, additional information may be found in the status bar at the bottom of the MLP 

window. 
• When entering a spread, evolve allows partial entry for the second part of the spread. For example, if 

you were to enter 1.33/5 in the spot field, evolve will display 1.3300 / 1.3305. 
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The MLP 
window 

 

The MLP window is split into 4 sections. 
The common input area (top of the window) has fields 
for your currency pair, spot date and horizon. It also 
includes booking fields when the booking wizard is 
running. 
The next section (coloured red) is for inputting data 
which is required to get a price for a deal. The fields 
that are available will change depending on which 
product you are pricing, you will need to fill in most of 
the fields in the top section to get a price. 
The next section (coloured light grey) is for market 
data which evolve obtains for you. If you change 
details in the top section, evolve will automatically 
update the market data for you, EXCEPT spot. Spot is 
frozen from when you finish inputting a currency pair, 
but can be updated (along with all of the market data) 

by pressing . 
The bottom section (coloured dark grey) shows prices 
and Greeks. 

 Note: The MLP window can be ‘detached’ from evolve by dragging it away, pressing +  or 
selecting Detach from evolve from the View menu. 
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View profiles 

 

View profiles control how much information is displayed 
on the Multi-leg pricer depending on your role. 
If you have multiple views available, you may switch 

between them using the  key or by selecting Switch 
view profile from the View menu. 
If you have sufficient privileges, you may edit your view 

profiles by pressing + +   or by 
selecting Edit pricing view profile from the View menu. 
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Pricing a 
Single Leg 

 

1. Grid Created with leg already in it 
2. Type in a Currency pair 

this will unlock the grid and fill in the Horizon and 
Spot Date  

3. The Grid will now unlock 
4. To enter a Strategy, either enter the strategy code if 

you know it, or click the ellipsis button and select it 
from the list 

Note: Depending on which strategy you select, 
different fields will be available to you. For 
example, a Risk Reversal will create a group, 
where only the summary fields are editable. 

5. Enter data in the key fields for the product 

Note: Ratio links the relative weighting between 
notionals of different legs

6. The price and Greeks will be calculated and 
displayed by evolve. 
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Errors, 
warnings 
and limits 

If data that you have entered causes an error, exceeds 
tradeable price limits or generates a warning, or a change 
in market data causes an error, limit or warning; 

• an exclamation symbol (!) will be displayed at 
the top right corner of the screen, 

• the leg/group in question will be highlighted in 
a different colour, 

• and a relevant message explaining the problem 
will be displayed at the bottom of the screen. 

• To view the error message: 

• click on the  symbol, press again to 
remove 

• or hover your mouse pointer over the 
relevant leg and a ‘tooltip’ will show the 
error. 

Note: Please ask the trading desk if you are in any 
doubt. 

 
 

Caution: This printed version (1.0 - Issued) is valid on the day it is printed only. Check the 
online version to ensure that you are working with an up-to-date copy. 

Copyright © 2007 HSBC Bank plc 

6 



Choicing/ 
un-choicing 

 

By default, the MLP shows the un-choiced (or bid and 
ask rates) in the market data and pricing-related fields. It 
is possible to show the choiced (or mid rates) instead. 
1. To toggle between choiced and un-choiced data 

• Select Toggle market data choice mode from 
the Pricing menu, or 

• Press F3 
2. To toggle the Choicing of an individual leg use 

+  

Note: Toggle once choices all relevant market data 
apart from the Pricing Vol, toggling again 
choices everything. (no price spread). 

Note: If market data is choiced, the leg header will 
change colour to bring it to your attention.  

   

Setting 
spreads 

 The MLP  lets you spread market data, volatility and 
price, even if you have selected to view mid rates only. 
You enter spreads in individual fields, which then revise 
related values accordingly. 
To set a spread, enter your first value, a space or / as a 
separator, then your second value. To clear a spread, 
press backspace. 

Note: See page 22 for formatting. 
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Adjusting 
entry data 
and market 
data 

 

In certain fields in the Entry data section (such as expiry 
and delivery dates, strike and amount) and some fields 
in the market data section (such as spot, forward, 
deposit, ATM Vol and Pricing Vol), the values can be 
adjusted up and down by preset amounts using the Insert 
and Delete keys respectively. 

Note: When overwriting or updating data it turns 
blue and can be cleared by backspace to 
return to the value provided by evolve in grey 

• To toggle between Call and Put, click in the 
required leg and press F2. 

Note: When using toggle functions such as call/put, 
buy/sell, exclude/include and so on, if you 
click in a group summary row or the main 
summary row, every leg within will toggle. 

• To toggle between Buy and Sell, click in the 
required leg and press + + . 

• To toggle between excluding and including 
legs from pricing, press + . 

 Note: If you change data in the MLP, evolve will automatically update the market data for you, EXCEPT 
spot. Spot is frozen from when you finish inputting a currency pair. Evolve will also re-calculate 
the price for you. 
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Working 
with Your 
price 

 
 

 

Evolve will show prices in appropriate units.  You can 

toggle between % / Pips and amounts using . 
The system will select appropriate % or Pip units 
depending on combination of Notional CCY and 
Premium CCY. 
Legs show Position/Value of trade.  The summary shows 
the Delta hedge you must trade and the premium you will 
pay or receive. 

Note: Delta hedge will always be expressed in 
CCY1. 

The highlighted (pink) line is the tradeable price.  This 
can only be dealt if the results area is not hatched and the 
leg heading is not coloured. 

 

TV 
adjustment 

 

TV adjustment allows you to adjust the price of the 
option by altering the ATM TV. The system will 
calculate a TV adjustment to make the TV(atm) into a 
tradable price, but this field can be overtyped, or you may 

use the  and  keys to nudge the percentage up 
and down respectively. 
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Price Spread  You can override the default price spread in either Pips or 
%.  The system will select the appropriate units 
depending on the combination of premium and notional 
currency. 

   

Adding More 
legs 

 

To add a leg to a group; 
• Click in one of the legs of the group and press 

, or 
• Right click on the group title and select Add 

new product leg, or 
• Select Add new product leg from the Quote 

menu. 
To add a new separate leg; 

• Select an individual leg and press , or 
• Select Add new product leg from the Quote 

menu. 

 

Caution: This printed version (1.0 - Issued) is valid on the day it is printed only. Check the 
online version to ensure that you are working with an up-to-date copy. 

Copyright © 2007 HSBC Bank plc 

10 



Selecting 
multiple 
legs/groups 

 

To select contiguous legs: 
1. Click on the header of the first leg or group 

2. Press  and click on the header of the last leg 
or group 

3. The first, last and all legs/groups in between will be 
selected. 

To select non-contiguous legs: 
1. Click on the header of the first leg or group 

2. Press  and click on the header of each 
required leg or group 

3. All the selected legs/groups will be highlighted, but 
not the legs/groups in between. 

Duplicating 
a leg 

 

1. Select the leg or group to be duplicated 
• Right click and select Duplicate Leg/Group 

multiple times; or 

• Press 
+ +

 to duplicate the 
leg once 

2. Enter the number of duplicates required 
3. Click OK 
4. The new legs or groups will be added at the end of 

the current quote. 
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Deleting a 
leg 

 

1. Select the leg or group to be deleted 
• Right click and select Delete Leg/Group; or 

2. Press 
+

. 

3. You can exclude a leg from pricing without having 
to delete it. Right click on the leg, and select 
Exclude leg from pricing. 

 

Groups of 
legs  

Complex products that consist of multiple legs are 
displayed as groups of legs in evolve. Groups of legs can 
also be created by the user to form complex products. 

 

Adding a 
group of 
legs 

 1. Select Add new group of legs from the Quote 
menu, or 

• Press 
+

, or 

• Right click on the MLP and select Add new 
group of legs 

2. Enter a display name for the group 
3. Click OK. 
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Moving 
Groups and 
Legs 

 

To move a leg/group: 
1. Click on the header of the required leg or group 
2. Right click and select Cut 
3. Right click on the leg that you want the cut leg to 

appear in front of and select Paste. 
 
To copy a leg/group: 
1. Click on the header of the required leg or group 
2. Right click and select Copy 
3. The copied leg/group may now be pasted wherever 

required, by right clicking on the leg/group that you 
want the copied leg/group to appear in front of and 
select Paste. 
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Strips  The Strip wizard allows you to create strips of deals 
across various dates as required. 

 Note: Formulae in Strips. 
Absolute formulae in strips will be accepted by the strip wizard. If you have relative formulae in 
strips, the wizard will prompt you to remove the formulae, make the formulae absolute, or keep 
them relative. 
If you choose to keep them relative, the wizard will make the first leg in the strips’ formulae 
absolute and all subsequent legs will be absolute from there on. 

Adding a 
strip 

 

 
Make sure you have priced legs. Legs without prices will 
not show in the wizard. 
1. Select Strip wizard from the Quote menu 
2. Select the trades to be stripped 

Note: Only trades with the same delivery dates can 
be stripped together. 

3.  Select what you would like to do with the original 
legs when the strip has been created 

4. Click Next 
5.  Use the Date generation controls to create your 

future trade dates 
6. Select dates to exclude from the strip and click 

Exclude if required 
7. Click Next 
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8. Enter a name for the strip 
9. Check the box to place all legs with the same date in 

a group each if required 
10. Click Finish to create the strips. 
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Scratchpad 
legs 

 

Scratchpad legs allow you to enter values and 
calculations which can be referred to from formulae 
within other legs. 
1. Open a scratchpad leg by selecting Add new 

scratchpad leg from the Quote menu, or by 

pressing + + . 

Note: You can enter figures anywhere at all in the 
scratchpad leg. The figures you enter do not 
have to relate to the rows that they are in. 
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Summary 
legs 

 

 

When you create a multi-leg deal or select a multi-leg 
product, a summary leg is created. Where selections/data 
is common across all legs, it is displayed in the summary 
leg. 
Changing data in the summary leg will affect all of the 
child legs. 
One can also hide summary legs by right clicking on each 
group summary or group title (to hide every summary in 
the group), then select Hide Summary, repeat this step to 
re-show the summary leg. 

Data common across legs 
is displayed in Summary
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Using 
formulae 

 

evolve has the option to use “MS Excel-like” formulae in 
its cells. 
In cells where this is available, the simple mathematical 
operators such as +, -, * and / may be used. Also relative 
and absolute references to other cells may also be used. 
1. Click in the required cell 
2. Enter an = sign 
3. The formula editor will open 
4. Enter the formula as necessary 
5. Click in another cell to create a reference 

• Enter $ to make the cell an absolute reference, 
or remove for a relative reference, or 

•  Press to toggle the $ on or off. 
6. Click OK to finish. 

Note: You cannot link live market data into 
formulae (only inputs – highlighted in blue) 
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Solving 

 

The MLP also allows you to reverse calculate (solve) 
many of the values in the fields. For example, you might 
want to calculate the strike level of an option for a 
specified price, or to calculate the vol given a certain 
price. 
1. Enter the required details for a leg 
2. Edit (overwrite) the field that you wish to solve from 

and press return 
3. Enter a ? in the field that you wish to calculate (your 

variable) 
4. Press return. 

Note: Solver can also be used on the Summary leg  
to solve for premium 

Note: evolve will remember that solving has been 
set for a particular field and will continue to 
solve for that field. Typing a new value in the 
‘variable’ field or pressing the Backspace key 
will remove the solving function. 
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Creating a 
chart 

 

If legs have all the required data, evolve can draw a 
single-line or multi-line chart of the data for you. 
The x and y (and z if multi-line) axis can be changed as 
can their upper and lower limits depending on your 
requirements. 
1. Make sure the data that you wish to chart is 

complete 
2. Right click on the leg and select Line chart or Multi-

line chart as required 

Note: If you right click on a summary row, the legs 
within the group will be charted, or you can 
select multiple legs and right click to graph 
the selected legs. 

3. Set the x and y axis and limits (and the z axis and 
limits if required) 

4. Click Draw to produce the chart 
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Saving a 
quote 

 

5. Select Save as from the File menu 
6. Enter a description to help you to retrieve the file 

later 
7. Enter any comments as required 
8. Click Save. 

 

Opening a 
quote 

 

1. Select Open from the File menu 

2. or press +  
3. Use the Pricing page search criteria to limit your 

results as required 

Note: The search will default to show every quote 
that you have saved and will automatically 
update as you change your criteria. 

4. Click on the name of the quote that you wish to 
open. 
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Formatting Evolve is particularly flexible with respect to the format of data it accepts and recognises; 
1. Date 

• 17 June 2007, 17 June (brings up current year), 17 Jun 07 170607, 17 06 07, 17/06/07, 17-06-07, 17/06, 
17 06, 17-06 

• 1d, 1w, 1m, 1y. 
• Dates can also be entered by double-clicking in the date field, then double-clicking again to open the 

date picker. Clicking on the required date will enter it into the field. 

Note: evolve does not accept US date format. 
2. Spot 

• evolve will take a variety of forms of data for spot depending on the currency pair. For example, for 
EUR/USD “1356” will be displayed as 1.3560. For USD/JPY “2” will be displayed as 200. 

Note: evolve will display 0.98 as 9800. 
3. Amount 

• Currency code then 1k, 1m, 1b, 1ex (standard form). For example usd1m gives USD 1,000,000. 
4. Strikes 

• as/atms = at the money spot. • a/atm = ATM convention (static data, spot, 
fw, 0 delta straddle). 

• af/atmf = at the money forward. • 20d = 20 delta spot. 
• a0s/atmstraddle = atm zero delta straddle. • 20fd = 20 forward delta.  
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 Calculate/recalculate results. +  Start booking wizard. 

 Toggle call/put. +  Delete selected leg. 

 Choice/unchoice quote market data. +  Exclude selected leg from 
pricing. 

 Flip quote convention. +  Detach current window from 
evolve. 

 
Add a new leg (if a group is selected, 
the new leg will be added to the 
group). 

+  Add new group of legs. 

 
Toggle result display units between 
percentage and premium currency. 

+  Create a line chart. 

 Clear quote. +  Create a multi-line chart 

 Refresh market data. +  Open a saved quote. 

 Switch view profile. +  Save the quote. 

+  
Unchoice market data for selected leg 
only. 

+ +

 
Toggle buy/sell on the selected 
leg. 

+  
Flip orientation between vertical and 
horizontal. 

+ +

 
Create one duplicate leg from 
the selected leg. 

 
Increases dates or values by preset 
amounts in input and market data 
fields. 

+ +

 
Add new scratchpad leg. 

Keyboard 
shortcuts 

 
Decreases dates or values by preset 
amounts in input and market data 
fields. 

 (backspace) 
Removes overwritten data and 
restores market data/price data. 
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Help If you encounter any errors with evolve: 
1. Select Report an issue to evolve support from the Help menu 

 
2. This will create a file on your desktop (as below) 

 
3. Email the file to #evolve Support 
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